ANALOG projects 3

User Manual
Contents

1. Installation and Registration ................................................................. 3
  1.1 Installation on Windows ................................................................ 3
  1.2 Installation on Mac ...................................................................... 4
  1.3 Installation of Adobe Photoshop© Plug-ins................................. 5
2. Photos Done Quickly ........................................................................ 21
3. Optional: Image Preparation ............................................................ 22
4. Post-Processing: Presets ................................................................. 23
  4.1 Comparison View ...................................................................... 25
  4.2 Real Time Processing ............................................................... 25
  4.3 High-Quality Display ................................................................ 25
  4.4 Combine Default Settings ........................................................ 26
  4.5 Import/Export from Presets ........................................................ 26
  4.6 Name Favourites ...................................................................... 27
  4.7 Select a Preset ........................................................................ 28
  4.8 Presets and Origins for the Categories ....................................... 29
5. Post-Processing: Finalise ................................................................. 32
  5.1 Intelligent Colour Space (SCA Processing) ................................. 32
  5.2 ANALOG projects 3’s film emulation engine ............................. 33
  5.3 Post-processing Effects and Selective Application .................... 34
  5.4 Optimisation Assistant ............................................................. 37
  5.5 Scratch and Sensor Errors ....................................................... 38
  5.6 Custom Presets ..................................................................... 40
6. Workflow ......................................................................................... 41
  6.1 Edit final image further in an external program ....................... 41
  6.2 Work with a timeline and restore points .................................. 42
  6.3 Selecting and Saving Sections of Images ................................ 43
  6.4 RAW Processing ...................................................................... 45
  6.5 Batch Processing .................................................................... 48
  6.6 Add-ons ............................................................................... 49
Support ........................................................................................... 50
1. **Installation and Registration**

1.1 **Installation on Windows**

The start screen for the installation will normally be automatically displayed. If the auto-start function of your CD/DVD drive is deactivated, open the start screen manually by going to My Computer, double clicking on the CD/DVD drive symbol and then **Starter.exe** or **Starter**.

Once you are at the CD start screen click on **ANALOG projects 3 install**. Choose German or English as setup language and follow the installation assistant’s instructions.
Upon starting **ANALOG projects 3** for the first time, you will be prompted to activate the program. Proceed as follows:

Install **ANALOG projects 3** as described by the installation wizard. Input your serial number. For the box version, this can be found on the accompanying booklet. If you have chosen to download the program, you will have received the serial number by email directly following your purchase.

![Serial Number Input]

Finally, click on the **Activate now** button. The software has now been successfully activated!

**Note:** **ANALOG projects 3** can be installed on up to two computers using the same serial number. A second serial number is not necessary. When installing the program on a second device, simply enter the serial number again and press **Activate**.

### 1.2 Installation on Mac

Load your CD into your CD/DVD drive and open the installation menu through the desktop.

Drag the **ANALOG projects 3** file into the program link.

To use the Adobe® Photoshop plug-ins, open the Adobe® Photoshop plug-ins folder and copy the appropriate plug-ins into your Photoshop plug-ins folder.
1.3 Installation of Adobe Photoshop© Plug-ins

During the installation, you will be asked if you would like to install the Adobe® Photoshop plug-in.

If you agree to this, you can use **DENoise projects** as a plug-in for Adobe® Photoshop. Alternatively, the plug-ins can also be manually copied into the Adobe® Photoshop plug-in folder. Select the plug-in entry folder in the CD start menu to open it.

Additionally, the latest plug-ins for your software are available at: [http://www.projects-software.com/plugins](http://www.projects-software.com/plugins)

1.3.1 Windows 32 Bit Operating Systems

1. Complete the installation of **ANALOG projects 3** by activating the software.

2. For some reasons it may occur that plug-ins cannot be installed automatically in all Adobe Photoshop© versions. They have to be copied into the plug-ins folder of Adobe Photoshop© manually.

3. Please close Adobe Photoshop© as well as the stand-alone version of **ANALOG projects 3**.

4. Open the installation package folder of **ANALOG projects 3**. Here, you will find the plug-ins for all versions of Adobe applications that are supported.
5. Open the plug-in folder of your Adobe application (in this instruction the installation of the plug-in will be demonstrated for Adobe Photoshop© CS6).
6. Copy the file `ANALOGProjects3_PH6_x86.8be` from installation package and paste it into the plug-ins folder of Adobe Photoshop© CS6 that you will find here: 

`C:\Program Files\Adobe\Adobe Photoshop CS6\Plug-ins`

![Image showing file location](image)

7. Restart your Photoshop application and open an image.

8. Navigate to **File → Export → ANALOG projects 3...**. One click will start the plug-in.

The image will now be opened in **ANALOG projects 3**. The plug-in will **not** be in the Filter menu.
1.3.2 Windows 64 Bit Operating Systems

1. Complete the installation of ANALOG projects 3 by activating the software.

2. For some reasons it may occur that plug-ins cannot be installed automatically in all Adobe Photoshop© versions. They have to be copied into the plug-ins folder of Adobe Photoshop© manually.

3. Please close Adobe Photoshop© as well as the stand-alone version of ANALOG projects 3.

4. Open the installation package folder of ANALOG projects 3. Here, you will find the plug-ins for all versions of Adobe applications that are supported.

5. Open the plug-in folder of your Adobe application (in this instruction the installation of the plug-in will be demonstrated for Adobe Photoshop© CC 2015).
6. Copy the file `ANALOGProjects3_PH7_x64.8be` from the installation package and paste it into the plug-ins folder of Adobe Photoshop© CC 2015 that you will find here: `C:\Program Files\Adobe\Adobe Photoshop CC 2015\Plug-ins`

7. Restart your Photoshop application and open an image.

8. Navigate to File → Export → ANALOG projects 3…
   One click will start the plug-in. The image will now be opened in ANALOG projects 3.
   The plug-in will not be in the Filter menu.
1.3.3 MAC OS X Operating Systems

1. Complete the installation of ANALOG projects 3 by activating the software.

2. Open the installation package folder of ANALOG projects 3. Here, you will find the plug-ins for all versions of Adobe applications that are supported.

3. Please close Adobe Photoshop© as well as the stand-alone version of ANALOG projects 3.

4. Additionally, the latest plug-ins for your software are available at: http://www.projects-software.com/plugins

5. Open the plug-in folder of your Adobe application (in this instruction the installation of the plug-in will be demonstrated for Adobe Photoshop© CC 2015).
6. Copy the file **ANALOGProjects3_PH7.plugin** from the installation package and paste it into the plug-ins folder of Adobe Photoshop© CC 2015 that you will find here: Applications/Adobe Photoshop CC 2015/plug-ins

7. Restart your Photoshop application and open an image

8. Navigate to **File → Export → ANALOG projects 3...**. One click will start the plug-in. The image will now be opened in **ANALOG projects 3**. You won’t find it as another filter.
ANALOG projects 3 – User Manual
1.3.4 Adobe Lightroom Interface with ANALOG projects 3

Windows Operating Systems

1. Open Adobe Lightroom.

2. Open **Edit/Preferences/External Editing/Additional External Editor**.

3. In **Additional External Editor** choose the application **ANALOG projects 3.exe**
4. Click **OK**.

5. Right-click on a picture in Adobe Lightroom.

6. Choose **Edit In → Edit in ANALOG projects 3.exe...**

7. If you still cannot find **ANALOG projects 3** in the “**Edit In**” list please check if the **ANALOG projects 3** application is definitely set as external editor and restart Adobe Lightroom.
MAC OS X

1. Open your Adobe Lightroom Application.

2. Open **Preferences/External Editing**.

3. Navigate to section **Additional External Editor** in the middle of the window. There is no application specified as default setting.

4. Click on **Choose** in order to open the application folder of your MAC and to set your external editor.
5. Navigate to the ANALOG projects 3 application and click once to highlight it. Confirm with Choose.
6. **ANALOG projects 3** has been set as external application now.

7. Close that window and restart Adobe Lightroom.

8. Open an image from your Adobe Lightroom catalogue. Click on the picture while holding down the CTRL key.
9. Choose **Edit In → Edit in ANALOG projects 3...** and your photo will be opened in **ANALOG projects 3**. It will not be saved here: You can edit your image with **ANALOG projects 3** and then go back to Adobe Lightroom for more adjustments without wasting too much disc space. When you finished editing your picture you have to save the developed photo only one time.

If you still cannot find **ANALOG projects 3** in the “**Edit In**” list please check if the **ANALOG projects 3** application is definitely set as external editor in the Preferences menu of Adobe Lightroom.
2. Photos Done Quickly

You can obtain a finished image in just 4 clicks with ANALOG projects 3:

1. Load Images
2. Post-Processing Preset Selection
3. Optimisation Assistant
4. Select Image Detail and Save

You can simply drag and drop your images onto the start screen

How to get the results you want, and fast - the elaborated presets and looks, individual image adaption and selected drawing allow you to also go the creative route. ANALOG projects 3 offers both options.

Alternatively, you can also use the toolbar buttons or drop-down file menu.
3. Optional: Image Preparation

Click on **Extras/Preparing image...** Here you can precisely configure the image preparation settings or select the standard settings and turn off the image preparation window which pops up upon uploading photos. For the first steps, select the standard settings. Clicking the back arrow at the bottom left restores any changes made here back to the standard settings, so nothing is irreversible.

a. Colour space conversion: advanced users can choose a colour space here - for all other users, it is recommended to not make any adjustments, to avoid incorrect colour rendering later.

b. White balance: corrects colour casts that occur with shots taken, for example, in a warmly lit room. To start, leave this setting unchanged.

c. The colour temperature ranges from 1000K to 16500K, which makes for a powerful tool for establishing warm and cool moods.

d. The **checkbox** at the bottom edge of the window allows you to choose if you would like to have this window displayed when uploading images or not.

e. The **backwards arrow** returns all adjustments back to their initial values.

f. Exit image editing and switch to post-processing mode using this arrow.
4. Post-Processing: Presets

A change from previous versions, we are starting directly with post-processing after uploading the images. Here we can control the picture’s tone mapping and edit the results with filters and effects.

Left side of the post-processing screen: the presets show the breakdown of the live preview in categories with the quantity of presets in the appropriate category:

- “All”
- “Wet Plate”
- “vintage”
- “Pocket Camera”
- “Plastic Lens”
- “Camera Obscura”
- “Roll Film”
- “Polarisation”
- “Old Newspaper”
- “Lomography”
- “Freestyle”

To begin, we’ve chosen the “Wet plate 1” preset. Clicking on the preview image applies the effect to the image in real time, which will then be displayed in the middle of the screen. Discover the wide variety of different looks by clicking on the 102 different presets. You will be amazed by the intriguing styles in the artistic section!

All 102 ANALOG projects 3 presets at a single glance. The “Default settings” section can be separated from the rest of the interface by clicking on the "Default settings" bar, which then allows you to adjust the size of the window as preferred.
4.1 Comparison View

Do you want a comparison to the image without tone mapping? Simply right click on the middle of the image to see the before/after result. A quick check on the editing process is available at any time. For an extensive overview with selectable areas and luminance display, click on the symbol bar.

4.2 Real Time Processing

When activated, all of the changes that you have made to the preset settings will be immediately applied to the image and you will see the outcome of your adjustments directly.

4.3 High-Quality Display

Activate this option to see the preview image in high-resolution. If the preview is set at 100%, there will be no difference. If you zoom in on a section of the photo however, there is a noticeable difference in quality.
4.4 Combine Default Settings

To merge two looks together use the "Combine default presets" button directly under the categories. These new presets will be saved under "Custom". It’s that easy to expand your numerous options and accumulate new ideas!

4.5 Import/Export from Presets

Presets from earlier versions can be easily imported. Do you want to exchange all of your presets with a friend or just secure all of your treasures? Use the practical export function.
4.6 Name Favourites

Have you found certain presets that you love and instantly want to have handy? Click on the top right star in the preset window and add the setting to your favourites. By clicking the button, previews all of your favourite presets will be displayed.

➤ Filter Presets

Locating presets can be difficult when you have imported presets or created many additional looks. For example, enter “vintage” into the search bar and only presets relating to “vintage” will be shown.
4.7 Select a Preset

After loading an image, we now see the photo with its effects as a Real Time Preview in the middle, and the Presets (image suggestions) in the bar on the left.

We are currently in the Lomography category, the second preset from the top and outlined in green. The presets are divided into 10 categories to make them easy to find. Switch categories and click on Pocket Camera. Now you can browse through the range of previewed examples from the top category and look at them in the Real Time Preview. Take your time to click through the list and take in the fascinating possibilities!
4.8 Presets and Origins for the Categories

**Wet Plate:** The look for this category is adapted from the beginnings of photography. Glass plates were coated with collodion and treated with silver nitrate. Still damp, these plates were then used in field cameras. The plate would have to be developed immediately following exposure, which meant that photographers always had to have a darkroom with them. These various presets imitate diverse chemical processes and substrates used for wet plates. Experimenting is emphatically encouraged!

**Vintage:** Here you can find classic, retro and up to the minute styles for all presentational purposes. These days, the emotionally charged photo styles from the 50’s through 80’s have a major influence on online retailers, websites and blogs. And we know that you want to try out everything that can be done with a smartphone on your big PC screen even more! Get inspired and create your own hip vintage style.

**Pocket Camera:** Don’t be afraid of leaked light, colour deviation or lens flares. These presets are based on cameras from the 60's and 70’s, like the legendary Kodak Instamatic and Agfamatic cameras. Technically “correct” is something different; here you can combine all of the available tools as you fancy - this is pure emotion. Here is an example of a lovely portrait that just needs that last finishing touch:
Portrait Shots: Filters 2 and 10 from the “Pocket Camera” category make the photo brighter, friendlier and more emotionally appealing.

**Plastic Lens:** The hot “trash” look from Holga plastic lenses is simply optimal for soft portraits and gentle landscapes. Since the lenses are often misaligned, the edges end up blurry, which has its own charm and brings the focus to subject in the centre. If you are looking for sharpness through and through, you might want to pick a different category.

**Camera Obscura:** Over more than 2000 years ago, Aristotle discovered the phenomena of the “camera obscura”. Camera obscura essentially means “dark room”. In a darkroom, Aristotle observed that an image was inverted when projected through a small hole onto an opposing surface. And that’s how he discovered the fundamental idea of photography.

Tip: If you are interested in using some of this category’s features, but would rather not turn your image upside down, just click on the “Projection” option in the filter to turn the mirroring off.

**Roll Film:** Rollfilm was the film used for decades by high end cameras like Hasselblad, Mamiya 6x7 and Rolleiflex 6006. When it comes to shooting in analogue style today, rollfilm is still prefered. Even here, you aren’t safe from light leaks in the developing tank. Once fully processed, frame your photos with professional filmstrips - there’s lots to choose from.

**Polarisation:** In the 70’s, everyone wanted to immediately have prints in their hands, and thus the popularity of the Polaroid camera. In the beginning, this technology required development times of different lengths, which lead to photos with a prominent tint. Similarly, the base substrate and coating lead to a mild 3D effect, which is recreated in the various presets. The Polaroid movement never really came to an end; after fine-tuning of Polaroid film production in 2008, other companies continued to produce the devices, and there are even new Polaroid cameras on the market today.

**Old Newspaper:** Here you’ll find must-have presets like coarse resolution, paper structure, sepia tones and blotches.
Lomography: “Lomo” is the name of a simple plastic camera which caused an entire photography movement. The images shot with this camera or similar ones are characterised by technical errors, poor resolution and blurriness. The results are difficult to predict, which is exactly the charm. In an age of perfect digital cameras, the element of surprise and the excitement around how an image will turn out can be quickly missed. Discover a completely new philosophy of photography and riffle through the Lomo presets. You can tell right away that our developers have fun making these!

Freestyle: Everything is allowed in this category! Lots of freely inspired styles of all sorts. Find out what works best for your photo or create your very own crazy style!
5. Post-Processing: Finalise

Now that we have understood the most important part of post-processing, let’s go onto fine-tuning, which can be found on the right side of the screen under "Finalise". These features are intended to only to be used to edit pictures further after selecting a preset.

5.1 Intelligent Colour Space (SCA Processing)

This menu offers you options for optimal colour detail gradation of your tone mapping results. Selecting SCA processing (Smart Colourspace Adaptation) demonstrates differences in the details of more saturated colours.

Tip: With “Supersampling” you will get exceptional details and saturated colours!
5.2 ANALOG projects 3’s film emulation engine

**ANALOG projects 3** includes film looks from the legendary days of analogue film, thanks to its film emulation engine.

Rummage through a box of old photos - it’s worth it! Select a type of film and its specific colour characteristics, such as grain and contrast film effects, to apply to your picture. You can regulate the intensity of individual features as well as the overall effect of a film look.

"Photo Film Emulation" can be found on the ride side of the screen under “Finalise”. What would analogue photography be without the magic of different types of film?

**ANALOG projects 3** offers you a complete emulation engine with colour film, diafilm, and black & white film - which you definitely have to try out!

You are on the hunt for authentic looks with all of the strengths, weaknesses and emotions from back in the day? You’ve come to the right spot.

In this case, grain is desired as a creative tool and can be separately adjusted for each type of film. Give the various films a try and discover new, unique characteristics.

---

**Agfa Futura**: All-round film with a wide exposure scope, and forgives an occasional faulty exposure. This camera isn’t best known for sharpness but is therefore well suited to portraits.

**Fuji**: Enhances the yellow and green elements of the image, and is the first choice to give lomography shots that last finishing touch.

**Fujichrome**: This film was originally introduced for fashion and product photography. Works excellently with the rollfilm presets.

**Kodak**: Everyone knows the unmistakable look of the Kodak Ektachrom 64, which made its mark with fine grain, lush colour rendering and outstanding brilliance. It is the film for eternity. 30 years of storage is nothing for this medium, which means that it is again and again the film of choice for image archives. Even private dia-collections are kept notably well with this film.

**Efke**: Black & White film from Efke is distinguished by rich grayscale reproduction and great sharpness. Since the manufacturing process hasn’t changed in 50 years, it can’t compete with modern film in regard to grain. This film characterises the black & white look of the 50’s and is as modern today as ever before.
Ilford: Generations of photographers have used Ilford film, and simply belong to the digital darkroom. The legendary Pan F with its ISO 50 is one of the sharpest films and has been used for architecture, still life and fine art prints for eons. In the other corner is the beloved HP5, the film for photo journalists, who also have to document at night. The film is moderately gritty, however works for exposures up to ISO 3200 and is a jack of all trades.

Kodak T-Max: The T-Max 3200 was the film of choice for night photography or available light situations, however you had to be careful of the quickly appearing grain. Today’s generation of T-Max is fine grained in comparison and literally a dream for shots with little light.

Tip: If you want to quickly convert a colour image into black & white, go ahead and select a colour preset. You can select a black & white version at the end in Film Emulation. It’s that easy!

5.3 Post-processing Effects and Selective Application

ANALOG projects 3 has 59 expert filters that you can discover one after the other. We would like to show you a few that are near to our hearts, and that you can apply for dramatic results.
To find the filters, type the name into the search bar above post-processing effects. ANALOG projects 3 will find it quickly for you!

Form vignette: Imitates the vignetting effects of older lenses and is an important stylistic device for vintage looks.

Image Toning: The tool of choice to add colour casts to an image. Give selective editing a try and limit the toning to one area of the image.

Structure - lights, paper, dust & spots, stone: You have landed in a designer’s playground. With the Structure - lights effect for example, you can establish a completely new atmosphere with just a single click - a feat which would require laborious levels and masks with other photo editing software. Dust and spots, paper and stone structure filters top off your creative possibilities. If you like it, it’s allowed! Select the effects in the texture browser and try them out - it brings life to life!
**Bokeh Blurring**: Everything sharp? In professional photography, larger areas are often not sharp on purpose, in order to direct the focal point. These unsharp sections are called “bokeh” and are just as crucial as investing in sharp lenses. Emulate the silky-softness of bokeh produced by the most expensive lenses. Just quickly mark a selection and the main motive is set in a magnificent scene. Activate the “Bokeh blurring” filter by double clicking. The effect will now be applied to the entire image, however we want the central focus to remain sharp.

For that we switch to selective mode, found at the top left of the Effects window.

Select the area that is to be excluded with the red circle and set the square on the main subject. We can now close the window - and done!
**Soft contrast:** Use this method to quickly generate movement effects - the weapon of choice to liven up static images.

**Dynamic brightness:** This new feature from **ANALOG projects 3** adds a specifically set glimmer of light and makes every image into a fascinating eye catcher.

**Aura:** Soft light in the background can help to steer attention towards the main subject and be applied in many different ways.

**Exposure Errors:** This filter is especially trendy for the Lomography and Pocket Camera categories. Since cameras back then often weren’t completely light-tight, the film had stripes from light leaks. Browse through the texture library to see everything there is to try. You are sure to find gold.

![The Effect Texture Browser contains various light effects for styling your images. You can also combine multiple effects by simply selecting the “Exposure Error” option a second time.](image)

**Glamour lighting:** This effect filter is especially irresistible for portraits.

**Frames and Film Frames:** With **ANALOG projects 3**, you can simply produce subtle frames yourself or select a film frame from the library. Makes for an exquisite finishing touch.
Tip - creating your own looks: Apply a preset containing the post-processing effects you consider to be the most important, deactivate all the filters by clicking on the checkmarks and save the file. Upon loading a new image, you can process all of your applied effects from top to bottom and quickly develop your own style.

5.4 Optimisation Assistant

The optimisation assistant is a very efficient tool for fast, fascinating results. When the preset is activated, denoising, tonal value, clarity, dynamic and sharpness settings can all be adjusted by sliding the control to the left or right. The result can be seen live.

The optimisation assistant is intelligent; it remembers the values you entered, and applies the same settings to the next image in the same way, but tuning the result to the new motif.

If you would like to edit without the assistant, you can simply turn it off. If you would like to turn off the values that have been “learned” so far, click on the button.
5.5 Scratch and Sensor Errors

Micro-contrast enhancement used in photography unfortunately shows every unwanted sensor imperfection that every photographer, despite internal camera sensor cleaning, knows and dreads. Don’t stress - just eliminate them! With the easy to apply correction function from ANALOG projects 3, it can even be fun.

Pro Tip: This intelligent correction doesn’t only remove sensor spots, but other disturbing things too - a deserted beach has never been so easy to produce. Lightly mark defects in your motif, the program will automatically substitute these areas with other appropriate parts of the image.

Here’s how to go about correcting:

Select the brush tool under (6) and click on the point of the image that you would like to correct. A circle will appear beside it that will serve as a source.

Move this circle to a place on the image that can act as a source for the first marking. The selected area will then be improved based on the source.

Prior to this, you can reveal sensor spots, which will appear as a bright patch in the image, with (1).

(2) Allows you to expose or hide the fixed areas even when the corrections are still active, even if they have been blended in. Hiding is solely to enable a before and after comparison.

You can select multiple areas to correct by simply clicking on the brush symbol (6) and adding another point.
The button marked (3) can blend the targeted corrections in and out, which also controls clarity.

(5) Deletes the added corrections.

The section marked (7) controls the size of the area that is to be corrected.

You also have the option to automatically search for the best source area for the improvement. Click on the (8) button.

Button (4) calculates the appropriate correction spots for all of the points automatically set using (8).

All currently selected corrections can be deleted with the (9) button.

The sensor spots are circled in red
The sensor spot corrector marks all of the patches and determines a source within the image that can be used as a substitute.
5.6 Custom Presets

One thing is certain, regardless of which settings you have changed, if you have applied additional filters or adjusted a filter’s settings, the selected preset has been modified and to the right of the preview image is the following symbol:

Clicking will reset the preset back to its initial state.

**Careful:** All of the modifications applied up to this point will be undone!

Clicking saves all of the changes in a new preset. A dialog box will open where you can enter a new name for your preset or confirm the suggested one. The system will name it “Copy”.

The preset will be saved and moved to the “Custom” presets category.
The new preset has been additionally generated and the starting preset is preserved. You can also never overwrite a default preset!
6. **Workflow**

6.1 **Edit final image further in an external program**

**ANALOG projects 3** offers interaction with external programs. That way you can take a successful image result to another photo editing program and continue there.

6.1.1 **Open in other projects programs**

Click on the “Projects” symbol in the toolbar to open the image in a different program from the projects series. Use the drop-down menu beside the symbol to choose one of the programs that you already have installed on your computer.

6.1.2 **Open in other photo-editing programs**

To directly open the image in another photo editing program, such as Adobe Photoshop, click on the corresponding button in the symbol bar.

If necessary, go through the settings to show the path to the program. Click on “Extras” in the menu and select “Settings” in the drop-down menu:

Next, click on the “Export” tab. You can enter the name of a photo editing program here, and save it for later as well.
6.2 Work with a timeline and restore points

This option can be found in the symbol bar at the top edge of the screen:

“Create Restore Point” saves an in-between point of the current settings. You can now always return to this stage of your editing. You can save as many editing restore points as you like. The timeline displays the restore points and makes it possible to call up any phase with just a single click:

This function is especially useful when, for example, you are satisfied with an image, yet want to continue trying out different settings and effects.

Simply set a restore point and carry on editing your picture. If you want to go back, simply click on your restore point in the timeline.
6.3 Selecting and Saving Sections of Images

To save a final image, click on the button in the toolbar, go through the file menu or use the corresponding keyboard shortcut (Ctrl+S or CMD+S with MAC).

- **Cropping and captions**

As soon as you have initiated to save a file, the cropping and caption window will open.

At the top are several practical aids for perfect image composition and cropping.

You can set the aspect ratio and activate guidelines like the rule of thirds, the golden section or the golden spiral.

The centre of the window shows your final image. Fix the area to be saved by adjusting the corners and borders of the photo.
At the bottom is an option to enter a caption. You can determine the size, position and background for the text. The size of the text will be automatically coordinated to the final cropping.

You can either crop free-handedly or use one of the provided formats.

As soon as the image has been cropped and captioned, confirm the save and the following window will prompt you to select a file format and name your file.
6.4 RAW Processing

You can upload and edit RAW image data with the integrated RAW mode. Numerous tools are available to you here, such as denoising/sharpen, exposure, colour, detail and powerful distortion capabilities.

*Interfering chromatic aberration can be easily removed in the “colour” category*

An overview of the most important RAW functions:

**White balance:**
Here you can regulate the colour temperature. Use the pipette to select a white balancing colour directly from the image.

**Denoising/sharpness:**
This feature regulates the image’s noise and sharpness. Control the quality and different types of noise such as colour noise, banding or hot pixels.

**Colour balance/white balance:**
Here it’s all about colour and black/white correction. Modify the general colour mood and neutralise white and black - the icing on the cake for professional colour correction.
**Exposure:**
Influence lights, shadows, contrast and brightness in the final image.

**Detail:**
Fine-tune clarity and micro-details with lights, shadows and midtones.

**Colour:**
These colour settings are all about the luminosity of lights and shadows. You can even reduce the presence of unwanted chromatic aberrations.

**Palate:**
Adjust the saturation of individual colours.

**Distortion:**
Take a closer look. These mighty tools can straighten out the horizon, correct camera angles and lens errors. Use “Autofit” to automatically trim any awkward borders.
**General:**
Activate the “360° panorama mode” to optimise matching edges of images in a panorama series.

Save your settings as a camera profile to save time in the future. This can be reset at any time.
6.5 Batch Processing

ANALOG projects 3 batch processing allows for automatic processing of multiple bracketing series. The function can be found in the drop-down menu for “Extras” in the menu bar.
**Note:** Remember that looking through folders with several subfolders can require a lot of time. That’s why selecting “C:" is not recommended.

- **Results:** Here you can set where the resulting images of the batch processing will be saved. Select the corresponding folder with the "Target directory (. . .)" button or enter the name of the folder directly into the text box.

- **Format:** You can choose from five different formats to save your resulting images. In form of .jpg and .tif, there are two 8-bit formats and two 16-bit formats, as well as one png format. JPG images are always the highest quality and TIF files are saved uncompressed and without defects.

- **Editing settings:** Choose which filters of the batch you would like to apply. From here you can also access image preparation and select presets to be administered to the image. If you would like to later assemble the edited images into a 360° panorama, select panorama mode to eliminate exposure and contrast edges in the individual images.

### 6.6 Add-ons

With help from add-ons, you can not only import presets, but entire post-processing modules can be integrated, which can be necessary to create new preset looks.

1. Extract the files from the downloaded zip folder.

2. Open your **ANALOG projects 3** version

3. Click on **Menu → Add-ons → Import Add-on**
**Support**

If you have questions regarding the installation, problems or errors of the software, please contact the FRANZIS customer support team.

**Contact form:** www.projects-software.com/contact

Please understand that your questions can only be answered directly by FRANZIS customer support. This is to give us the opportunity to constantly enhance our customer service for you and to make sure that you receive only the most qualified answers to all of your questions as fast as possible.

**This is how our customer support works best:**

Please have the most important details about your computer and about our product at hand when you call our customer support. These include:

- Name of the product
- Product **ISBN** (which you can find on the back of the packaging, above the easy to spot barcode).
- Operating system of your computer
- Technical details of your PC including all your peripheral devices

**Copyright**

Franzis Verlag GmbH has prepared this product with the greatest possible care. Please read the following conditions:

All the programs, routines, controls, etc., contained in this data media or within this download are protected by their respective authors or distributors as mentioned in the respective programs. The purchaser of this data media or of this download is authorised to use those programs, data or data groups that are not marked as shareware or public domain for his/her own purposes within the provisions of their designated use. He/she is authorised to use programs or parts of programs that are marked as shareware, freeware or public domain within the restrictions given by the respective programs or parts of programs. A reproduction of programs with the intent of distributing data media containing programs is forbidden. Franzis Verlag GmbH holds the copyright for the selection, arrangement and disposition of the programs and data on these data media or these downloads.

The data and the programs in this data media or within this download have been checked with the greatest possible care. Considering the large quantity of data and programs, Franzis assumes no warranty for the correctness of the data and a flawless functioning of the programs. Franzis Verlag GmbH and the respective distributors do not undertake neither warranty nor legal responsibility for the use of individual files and information with respect to their economic viability or their fault-free operation for a particular purpose. Additionally, there is no guarantee that all the included data, programs, icons, sounds and other files are free to use. Therefore the publisher cannot be held liable for a possible breach of third party copyrights or other rights.

Most product designations of hard- and software and company names and labels mentioned in this product are registered trademarks and should be treated as such. The product designations used by the publisher are basically as the manufacturer describes them.

© 2016 Franzis Verlag GmbH, Richard-Reitzner-Allee 2, 85540 Haar, München